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Copyright Notice 

Notice 

Document information is subject to change without notice by Siemens Industry, Inc. 
Companies, names, and various data used in examples are fictitious unless otherwise 
noted. No part of this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, for any purpose, without the express written 
permission of Siemens Industry, Inc. 

All software described in this document is furnished under a license agreement and 
may be used or copied only in accordance with license terms. 

For further information, contact your nearest Siemens Solution Partner, Authorized 
TALON Dealer. 

Copyright 2017 Siemens Industry, Inc. 

To the Reader 

Your feedback is important to us. If you have comments about this manual, please 
submit them to: SBT_technical.editor.us.sbt@siemens.com 

Other product or company names mentioned herein may be the trademarks of their 
respective owners. 

Printed in the USA. 

Cyber security disclaimer 
Products, solutions and services from Siemens include security functions to ensure the 
secure operation of building automation and control, fire safety, security management, 
and physical security systems. The security functions on these products, solutions and 
services are important components of a comprehensive security concept. 

Drafting, implementing and managing a comprehensive and up-to-date security 
concept, customized to individual needs, is nevertheless necessary, and may result in 
additional plant- or site-specific preventive measures to ensure secure operation of 
your site regarding building automation and control, fire safety, security management, 
and physical security. These measures may include, for example, separating networks, 
physically protecting system components, user training, multi-level defensive 
measures, etc. 

For additional information on security as part of building technology and our product, 
solution and service offerings, please contact your Siemens sales representative or 
project department. We strongly recommend to always comply with our security 
advisories on the latest security threats, patches and other related measures. 

http://www.siemens.com/cert/en/cert-security-advisories.htm
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FINlite Graphics Tool 

Overview 

This document discusses the following topics: 

● FINlite Graphics Tool Overview 

– User Interface Description for the FINlite Graphics Tool 

– Tips for Using the FINlite Graphics Tool 

● Using the FINlite Graphics Tool 

– Launching the FINlite Graphics Tool 

– Logging in to the Controller 

– Creating Graphics 

– Editing the Graphics Animation 

– Saving and Publishing the Graphics File 

– Creating Device Templates 

– Backing up Graphics
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FINlite Graphics Tool Overview 
The Field Panel Web Server Graphics Application is a graphic utility program called 
Siemens FINlite. FINlite can be used to create, modify, animate, and save graphics 
files to be used with the Web Server user interface. 

 

 

NOTE: 
FINlite does not use vector graphics, so the graphics are not scalable. Graphics must 
be created for the resolution of the monitor on which they will be displayed. 

Siemens FINlite can connect to a panel and bind graphical elements to data points. 
While connected to the panel, the user will be able to see current values, and 
command points to see the affects on graphics. 

Graphic files can be deleted from FINlite or the HMI. 

Graphics files can be backed up to the Internal Flash Drive (IFD )through the HMI, 
using the Graphics backup feature, and deleted using the Delete_file feature in the 
HMI.. 

 

 

NOTE: 
Siemens FINlite supports Windows 7 and Windows 10. 

 

 

NOTE: 
Siemens FINlite is an Adobe AIR application. 

Siemens FINlite provides the following operations: 

● Graphics creation and deletion 

● Graphics manipulation 

● Graphics animation 

● Test animation with live data before publication 

● Saving the graphics components to the user library for reuse 

● Publishing graphics to the panel(s) 

● Opening a pre-constructed graphics file from the local file system 

 

 

NOTE: 
In the Web Server user interface, it is recommended to limit the total number of 
graphic tabs and dynamic trend tabs that are open to six (6) for performance reasons. 

Graphics Application Workflow 

 

 

NOTE: 
Siemens FINlite supports .png and .jpg graphics file formats only. 
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1. Create a graphics background file using Designer, Auto CAD, or another designing 

tool. Save the file (as a .png or .jpg) to the local file system or hard drive. Use the 

designing tool’s Export feature to convert the native file type to a .png or .jpg format 

for use with Siemens FINlite. 

 

 

NOTE: 
After a new animation image has been added to the set of frames in FINlite’s 
Animation Editor window, existing images are sometimes automatically resized to 
match the frame added by the user. 

Before bringing them into FINlite, be sure the images to be added for editing 
animation are sized similarly to the existing images, to avoid automatic resizing 
issues. 

2. Open the pre-constructed graphics background file from Siemens FINlite to add 

animated graphics. The background file can be sized in the canvas before graphics 

are added. 

3. Once the graphics are published from FINlite to the panel(s), they can be viewed 

via the Field Panel Web Server user interface. See the Viewing Graphics in the 
Web Server User Interface section. 

User Interface Description for the FINlite Graphics 

Tool 

 

The drop-down menus at the top of the Siemens FINlite Application and the navigation 
pane bars on the left side of the Siemens FINlite Application allow you to work with the 
graphics files in many ways. 
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File Menu 

 

The File menu allows you to access the File commands: 

● New opens a new graphics file. 

● Open File opens an existing graphics file. 

● Close closes the current file. 

● Close All closes all open files. 

● Save allows you to save the current file. 

● Save As allows you to save the current file in a new location with a new name. 

● Save All saves all open files. 

● Publish allows you to download the graphics file to the panel so it is visible via the 
BACnet Field Panel Web Server user interface. 

● Create Device Template turns a graphics file into a device template. This allows 
you to relativize points for later reuse. Relativizing allows you to re-associate points 
to graphical components. This is important when creating a graphic associated with 
a specific FLN application number and using points from a selected FLN device. 

● Exit closes the application. 
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Edit Menu 

 

The Edit menu allows you to access the Edit commands: 

● Undo allows you to reverse the last action. 

● Redo allows you to reverse the last Undo action. 

● Cut removes the image from the file and puts it into the clipboard. 

● Copy puts a copy of the image into the clipboard. 

● Paste places the image from the clipboard into the file where the cursor is located. 

● Delete allows you to delete the highlighted object or file. 

● Select All allows you to select all files or objects simultaneously. 

View Menu 

 

The View menu allows you to access the View commands: 

● Show Side Panel allows you to open or close the navigation pane on the left side 
of the application. 

● Enable Choice Pop-up launches the three-button pop-up window accessible upon 
starting the FINlite application. The three buttons are: Open, Create, and User 
Guide. See the Launching the FINlite Graphics Tool  section. 
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Language Dropdown 

 

The Language menu allows you to change the language used in the FINlite 
application. 

Question Mark Icon 

 

The Question Mark icon opens the User Guide and product information. 

● User Guide opens the product documentation as a PDF. 

● About displays product information. 

Panels Bar 

 

The Panels bar allows you to connect to and access information from the available 
panels. 

● The Connect To Panel button opens the Panel Login window, which allows you to 
log in to the available, licensed panels. 



 

 

FINlite Graphics Tool Overview 

User Interface Description for the FINlite Graphics Tool 
 

11 | 32 

Siemens Industry, Inc.  A6V101102704 

 
 

2017-06-30 

 

 

Static Icons 

Static icons in the Panels bar indicate the various characteristics of the panel node. A 
static icon associated with a panel node is fixed for the Web session. 

 

Icon Description Indication 

 
Red shield icon with a 

horizontal white bar. 

FPWeb license is not installed for the panel. 

You must obtain and install an FPWeb license (LSM-FPWEB.T, 

LSM-FPWEBPL.T, LSM-FPWEBPLHST.T) in order to use 

FINlite features. 

 
Purple shield icon with a 

vertical white bar. 

Panel is not upgraded to the latest firmware. 

You must upgrade the panel to the appropriate firmware in order 

to use features associated with the version of the FINlite, such 

as the Delete Graphics feature. 

 
Both red and purple shield 

icons displayed together. 

FPWeb license is not installed for the panel AND the latest 

firmware has not been installed in the panel. 

Moving your cursor over the icon also indicates if the node has 

license restrictions and does not have the latest firmware 

installed. No FPWeb license and Not latest firmware. 

 

Dynamic Icons 

Dynamic icons in the Panels bar indicate the various states of the panel node. A 
dynamic icon associated with a panel node is updated when a change to the state of 
the panel is detected. 
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NOTE: 
You must perform a panel refresh before the dynamic icons will indicate a change of 
state. 

 

Icon Description Indication 

 Yellow triangle icon with a 

red exclamation point. 

Database File Synchronization. 

Field panel database file synchronization is in progress. 

 Orange triangle icon with a 

white exclamation point. 

Panel Not Ready. 

You must load the panel with a database from a software tool or 

front end computer, or use the Panel Configuration Editor in the 

Field Panel Web Server to make the panel ready. 

 Red triangle icon with a 

black exclamation point. 

Panel Communication Lost. 

Communication to the device has been lost (device failure). 

 

Components Bar 

 

The Components bar displays the available components which can be dragged and 
dropped to the canvas and customized. Supplied component images are intended for 
use with binary points. 

Layers Bar 
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The Layers bar allows you to create layers within the graphics file. Layers can be 
moved or locked. Components can be copied or moved to an existing layer or to a new 
layer. 

● The New Layer button creates a new graphics layer. 

● The Delete Layer button deletes the highlighted layer. 

Properties Bar 

 

Clicking a component in the canvas on the right side of the application, and opening 
the Properties bar in the left navigation pane opens the Properties area for the specific 
component. Each type of component has different customizable properties. 

Opening the Properties bar with nothing on the canvas allows you to customize the 
size and background color of the canvas itself. 

Customizable properties include, but are not limited to: 

● Name of the component. 

● Type of component. 

● Object the component is bound to. 

● Font size and color of labels. 

● Width and height of the component. 

● Background color and alpha (transparency) level. 
NOTE: The background color defaults to white, and the alpha level defaults to 100 
(no transparency). You may need to adjust these levels to achieve the desired 
appearance. 

● Alignment of the component within the background. 

● Invisible or visible on the completed graphics file. 
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Other features of the Properties area include: 

● The Locked check box, which ensures that no other changes are made to the 
properties. 

● The Edit Animation button, which opens the Animation Editor window. 

Animation Editor 
The Animation Editor allows you to customize the animation of a graphics component. 

 

See the Editing the Graphics Animation section for more information. 

File-System & User Library Bar 

 

The File-System & User Library bar displays your available local file system and the 
saved images and models. 

The User Library and File System buttons allow you to toggle between the folders. 

The Make Default Folder button sets the chosen folder as the default when you choose 
the Add to Favorites button in the Properties bar. 

The Folder button creates a new folder within the displayed file system. 

The Trash button deletes the highlighted folder or file. 
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The Canvas 

 

The canvas is the graphics workspace on the right side of the FINlite application 
window. 

The top left tab displays the name of the graphics file. 

The Maximize button allows you to maximize the workspace canvas and no longer 
display the left navigation bar (side panel). 

The Scale drop-down menu allows you to change the size of the workspace canvas. 

The Enter Live Mode button allows you to begin polling points and view the graphics 
animation through the FINlite application. 
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Tips for Using the FINlite Graphics Tool 

 

 

NOTE:  
Graphics can only be published to the Modular series and Compact series 36-point 
controllers. 

● Graphics files can be created and viewed via the Siemens FINlite Graphics Tool. 

● Graphics files can be viewed but not modified using the Graphics View in the 
BACnet Field Panel Web Server User Interface. See the Graphics View section. 

● Once published to a panel, graphics files can be modified using the same 
computer used to create them, or they must be copied manually from the field 
panel to a computer running the Siemens FINlite application. 

● If your system requires large graphics, it is recommended that you use a USB 
memory device (such as a thumb drive) to save memory. 

● Library components should be saved before bindings are made; otherwise, 
additional work may be required.
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Using the FINlite Graphics Tool 

Launching the FINlite Graphics Tool 
To launch the Siemens FINlite Graphics Application: 

1. Follow the instructions for the Tools Installer. 

2. Launch the FINlite application from the desktop icon created by the Installer, or 

from the Start menu icon created by the Installer. 

 After the application starts, the Choice window displays three button choices: 
Open, Create, and User Guide. 

 

3. To keep the Choice window from displaying upon start-up, check the Don’t show 

this again check box. 

4. Click the Open button to open an existing Graphics file from the local file system. 

NOTE:  A Graphics file can also be opened by selecting New from the File menu. 

5. Click the Create button to begin creating a new Graphics file. 

6. Click the User Guide button for assistance with the Graphics Application. 

Logging in to the Controller 
To log in to the controller: 

1. Click the Panels bar in the left navigation pane to access a specific controller. 

 The object list of the chosen controller displays. 

2. Click the Connect button. 

 The Panel Login dialog box displays. 
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3. In the Panel Login dialog box, enter the panel IP address, user name, and 

password. 

 The tool authenticates with the panel, retrieves the panel list, and then 
authenticates with all of the panels on the network. 

 Once the login is complete, the object list of the chosen panel displays in a tree 
format in the left navigation pane. 

 

 

NOTE:  
Check the Save Login Info check box to allow recently used IP addresses and user 
account information to be saved. 

User Account Passwords Using Double Byte Character Sets 

Double-byte characters cannot be directly entered in the password field in FINlite. In 
FINlite there are password fields whenever a connection is being made to a panel. 

You have the following options for passwords: 

● Use only single byte characters for user account passwords. This option does not 
require special procedures to enter the user account password in FINlite. 

● Use double byte characters for user account passwords. This option requires 
copying the characters from another field (such as the user name field) or another 
application (such as Notepad) and pasting the characters into the password field in 
FINlite. The location from which the characters are copied must support viewing of 
the double byte characters appropriately. 

Creating Graphics 
Click the Components bar in the left navigation pane to open the Components area of 
the FINlite application. 

Once a component is edited and customized, it is called a Model. Once a Model is 
saved, it can be reused in multiple graphics files. 

The Layers bar in the left navigation pane allows you to layer the components in a 
specific order. For instance, in a Graphics file, the Air Handler Unit (AHU) template 
may be on the bottom-most layer while all of the AHU elements represented by the 
components may be on the middle layer, with the labels on the top layer. Be sure to 
layer the background image first, and then layer buttons and labels on top. If the 
background is layered on top of a button, for example, the button won’t function 
properly. 
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To create a Model: 

1. Drag a component to the canvas on the right side of the FINlite window. 

2. Click the Properties bar in the left navigation pane to customize the features of the 

component. See the User Interface Description for the FINlite Graphics Tool 
section for more information. 

3. Click the Add to Favorites button in the Properties area. 

 The new Model is saved to the Models folder in the File System and User 
Library area of the navigation pane. 

 

 

NOTE: 
Library components should be saved before bindings are made; otherwise, additional 
work may be required. 

Label Component: 

Labels can also be modified to display updates of point name, status, value, 
description, priority, device name, and/or units. 

1. Drag a Label component to the canvas on the right side of the FINlite window. 

2. Click the Properties bar in the left navigation pane to customize the features of the 

label. 

3. To activate the label for point value updates or other point information: 

a. Once the label is bound to a point, the Text field will display a + sign, allowing you to 
choose point characteristics to add to the label’s Text field. Click the + sign and choose 
each characteristic, one at a time, until all desired characteristics have been chosen. 

b. Click on Enter Live Mode to see the live, updated status. 

The features of a Label component can be modified using the Properties bar: name, 
label text, bound point, size, position, background color, background color 
transparency, visibility, locked status, corner shape, font color/size, and font style and 
alignment. 

Button Component: 

The button component can be used for several different purposes. 

● If the button is bound to a Point, selecting the button opens the Point Commander 
for that point. 

● If the button is bound to a Graphic, selecting the button opens the bound graphic. 

● If the button is bound to a Schedule Object, selecting the button opens the 
schedule object for viewing. 

● If the button is bound to a Trend Log, selecting the button opens the Trend View 
and display the bound trend data. 

● If the button is bound to a Web page, selecting the button opens the bound Web 
page in a new window in the user’s browser. 

To bind a button to a point: 

1. Expand the Panels bar and connect to a panel on the desired ALN, if not already 

connected. 

2. Expand the Components bar and drag a button onto the workspace. 
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3. From the Panels bar, expand the panel with the desired point. Expand the Local 

section of that panel, and then expand the applicable point type (analog input, 

analog output, etc.). 

4. Select the point you want to associate with the button and drag it onto the button in 

the workspace (this binds the point to the button). 

5. Select the button on the workspace and expand the Properties bar. 

6. Verify that in the Properties area, the On Click field displays Open Resource and 

below this is the name of the desired point. 

7. Publish the graphic. A button bound to a point will not work unless the graphic is 

published to the panel and used through the user interface. If you try to use the 

button in FINlite, even in Live Mode, it will not work. 

8. Open the Graphics View in the BACnet Field Panel Web Server user interface, 

navigate to the published graphic, and open the graphic containing the button. 

9. Click on the button to bring up the Point Commander Application for the associated 

(bound) point. 

To bind a button to a graphic: 

1. Expand the Panels bar and connect to a panel on the desired ALN, if not already 

connected. 

2. Expand the Components bar and drag a button onto the workspace. 

3. From the Panels bar, expand the panel with the desired graphic, and then expand 

the Graphics section of that panel. 

4. Select the graphic you want to associate with the button and drag it onto the button 

in the workspace (this binds the graphic to the button). 

5. Select the button on the workspace and expand the Properties bar. 

6. Verify that in the Properties area, the On Click field displays Open Resource and 

below this is the name of the desired graphic. 

7. Publish the graphic. A button bound to another graphic will not work unless the 

graphic is published to the panel and used through the user interface. If you try to 

use the button in FINlite, even in Live Mode, it will not work. 

8. Open the Graphics View in the BACnet Field Panel Web Server user interface, 

navigate to the published graphic, and open the graphic containing the button. 

9. Click on the button to bring up the associated (bound) graphic. 

NOTE: Both the graphic with the button and the graphic that is bound to the button 

need to be published to their appropriate panels. 

To bind a button to a Schedule Object: 

1. Expand the Panels bar and connect to a panel on the desired ALN, if not already 

connected. 

2. Expand the Components bar and drag a button onto the workspace. 

3. From the Panels bar, expand the panel with the desired Schedule Object, and then 

expand the Schedules section of that panel. 

4. Select the Schedule Object you want to associate with the button and drag it onto 

the button in the workspace (this binds the Schedule Object to the button). 
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5. Select the button on the workspace and expand the Properties bar. 

6. Verify that in the Properties area, the On Click field displays Open Resource and 

below this is the name of the desired Schedule Object. 

7. Publish the graphic. A button bound to a Schedule Object will not work unless the 

graphic is published to the panel and used through the user interface. If you try to 

use the button in FINlite, even in Live Mode, it will not work. 

8. Open the Graphics View in the BACnet Field Panel Web Server user interface, 

navigate to the published graphic, and open the graphic containing the button. 

9. Click on the button to bring up the associated (bound) Schedule Object. 

To bind a button to a Trend Log Object: 

1. Expand the Panels bar and connect to a panel on the desired ALN, if not already 

connected. 

2. Expand the Components bar and drag a button onto the workspace. 

3. From the Panels bar, expand the panel with the desired Trend Log Object, and 

then expand the Trends section of that panel. 

4. Select the Trend Log Object you want to associate with the button and drag it onto 

the button in the workspace (this binds the Trend Log Object to the button). 

5. Select the button on the workspace and expand the Properties bar. 

6. Verify that in the Properties area, the On Click field displays Open Resource and 

below this is the name of the desired Trend Log Object. 

7. Publish the graphic. A button bound to a Trend Log Object will not work unless the 

graphic is published to the panel and used through the user interface. If you try to 

use the button in FINlite, even in Live Mode, it will not work. 

8. Open the Graphics View in the BACnet Field Panel Web Server user interface, 

navigate to the published graphic, and open the graphic containing the button. 

9. Click on the button to bring up the associated (bound) Trend Log Object. 

To bind a button to a Web page: 

1. Expand the Components bar and drag a button onto the workspace. 

2. Select the button on the workspace and expand the Properties bar. 

3. From the On Click menu, select Go to Webpage. 

4. Enter the desired URL address in the field below the On Click menu. 

5. Publish the graphic. 

6. Open the Graphics View in the BACnet Field Panel Web Server user interface, 

navigate to the published graphic, and open the graphic containing the button. 

7. Click on the button to bring up the associated (bound) Web page. 

The features of a Button component can be modified using the Properties bar: name, 
label text, on-click action, size, position, visibility, locked status, corner shape, font 
style/color/size, and button color/shading. 
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To create a Graphics file: 

1. Click the Components menu in the left navigation pane of the Graphics Application 

window. 

2. To assign an object to the component, click the arrows next to the panel and 

objects names in the navigation pane to navigate to the desired object from the 

object list in the left pane and drag it on top of the component that has just been 

dropped onto the canvas. 

3. Once all the desired components have been added to the canvas, click the Enter 

Live Mode button in the upper right corner of the window, above the canvas. This 

allows the panel to begin polling points and displaying current information on the 

graphic. 

NOTE:  While in live mode you can open the Commander application and command 
the objects to see the graphic being manipulated. However, if a PPCL program or any 
other application is influencing the object, the change will be seen without any user 
interaction such as using the Commander application. 

To Publish a Graphics File: 

1. From the File menu, select Publish. 

2. Open the BACnet Field Panel Web Server user interface. 

3. In the left navigation pane, click either the Devices/Points bar or the Graphics bar. 

4. Navigate to the panel to which the graphic was published. 

 The published graphic will display under the panel name. 

Editing the Graphics Animation 
Components can be further manipulated by editing the animation. Several images of a 
component can be saved individually to the user library for reuse with animation. Once 
an object is assigned to the component, the object can be commanded to different 
values. Each value commanded will access a different component graphic, which 
creates the graphic animation. 

To Edit the Animation: 

1. On the canvas, highlight the component you want to animate by clicking it. 

2. Click the Properties bar in the left navigation pane. 

3. Click the Edit Animation button. 

 The Animation Editor window displays. 

4. Use the Input Type, Values From, and To fields to customize the animation options 

for the component graphic. 

5. Choose a section in the values line (Boolean component types will have only 

“True” and “False”) by clicking in between the triangles. 

6. Use the Use Frame drop-down to choose an image to connect to the chosen value. 

The Animate check box will loop all chosen images when the object value is set to 
“True” (or any chosen value). This will give the graphic the appearance of moving. 



 

 

Using the FINlite Graphics Tool 

Saving and Publishing the Graphics File 
 

23 | 32 

Siemens Industry, Inc.  A6V101102704 

 
 

2017-06-30 

 

Saving and Publishing the Graphics File 

 

 

NOTE:  
Graphics can only be published to the Modular series and Compact series 36-point 
controllers. 

 

 

NOTE:   
Before transferring a file to a field panel, you must verify that enough RAM is 
available in the field panel to hold the entire file or it cannot be transferred to its final 
location. 

To save the Graphics file: 

● After the components are edited and the Graphics file is complete, save the 
Graphics file to the local file system by clicking Save from the File menu. 
Graphics file names must not:  
–  Exceed 20 characters in length 
–  Contain special characters: . \ / : * ? “ < > | (includes period) 
–  Contain characters with accent marks (such as é or ô) 

To publish the Graphics file: 

1. From the File menu, select Publish. 

 The Publish Graphic window displays, allowing you to name the graphics file, 
and select the panel and drive (A: or B: if available) to publish to. 
NOTE: Do not use a period or any of the special characters listed above in the 
file name. 

 

2. To set the graphic as the default graphic for the panel, check the Default check 

box. For more information on default graphics, see the Default Graphics section. 

3. Click Publish. 

4. The graphics files on Drive A can be backed up to the Internal Flash Drive (IFD) 

using the HMI. 

Default Graphics 

To set a default graphic for the panel: 
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1. When publishing the file, select the Default check box. 

2. Select Drive A. 

NOTE: Default graphics can only be saved to Drive A. If you select Drive B, FINlite 

will automatically change the selection to Drive A, graying out the Drive B row in 

the Drive table. 

3. Click Publish. 

 FINlite automatically renames the file to default.fnl. 
 When you connect to that panel from the BACnet Field Panel Web Server user 

interface, the graphic will display as the default graphic. 
NOTE: Because Device Template graphics are published to the 
Graphics\Application\AppID folder on the panel, rather than in the Graphics 
folder, they cannot be used as default graphics. See the Creating Device 
Template section for more information on Device Templates. 

Creating Device Templates 
You can create a graphics template from a single file for reuse with multiple FLN 
devices that have the same application ID. This is accomplished by using the Create 
Device Template  feature (also called relativizing a file). 

To Relativize a Graphics File: 

1. Create a graphics file using a background graphic and components. 

2. Connect to a panel. 

3. Bind points from one of the desired FLN devices to each of the components in the 

graphic. 

4. From the File menu, select Create Device Template. 

 The Relativize Mapping window displays. 

 

5. In the Relativize Points to Device drop-down list, select the panel to relativize to. 

6. Choose any or all of the device points to relativize by clicking the check boxes next 

to the point name(s). Checking the topmost check box will select all points. 

7. Click Relativize. 

 Once points are relativized, a circular arrow icon displays in the Relativize 
Mapping window, to the right of the point name. 
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8. To un-relativize any or all points, click the Un-relativize Points icon (the circular 

arrows to the right of the point names). Clicking the topmost icon will un-relativize 

all points. 

9. Save and publish the graphics file. 

 

 

NOTE: 
In order to relativize an existing graphics file, you must be connected to a panel. 

In the BACnet Field Panel Web Server User Interface 

To apply the relativized graphics file to an FLN device: 

1. Open the relativized graphics file. 

 

 

NOTE: 
Device Template graphics (relativized graphics files) are stored within the selected 
panel in the Graphics area, by application ID (Graphics\Application\ApplicationID). 

 

 

NOTE: 
Because Device Template graphics are published to the Graphics\Application\AppID 
folder on the panel, rather than in the Graphics folder, they cannot be used as default 
graphics. 

– A Select Device drop-down list will display in the Graphics Viewer on the right 

side of the Web Server. 

 



 

 

Using the FINlite Graphics Tool 

Backing Up Graphics 
 

26 | 32 

Siemens Industry, Inc.  A6V101102704 

 
 

2017-06-30 

 

2. Select the device whose live data should display in the relativized graphic. 

3. Click Go. 

 The relativized graphic will display the live data from the selected device. 

Backing Up Graphics 
Use this procedure to back up graphics files using the HMI. 

 

HMI S, H, E, W, G (System, Hardware, Ethernet, Webserver, Graphicsbackup 

 

 

 Example 

10:13:04 07/30/2010 FRI Logged on successfully Field panel <40091> 

User: <high> <High default user account> 

 

>Point, Application, Time, Message, Cancel, System, passWord, Bye? s 

>Diagnostics, Users, dSt, Bacnet, Error_msgs, Hardware, Text, Quit? h 

>Fieldpanels, Ethernet, nodeNametable, Disks, Reportprinter, 

Licensemanager, Quit? e 

>ipSettings, Bbmd, Telnet, Webserver, Quit? w 

>Display, Modify, Uiupgrade, Graphicsbackup, Quit? g 

>Are you sure : y 

 

DONE 

 

Deleting Graphics Files 
Graphics files consist of .fnl files and media files. Media files (backgrounds, component 
images, etc.) are shared among all graphics. The .fnl files are stored separately from 
the media files, and Device Template > FLN files are stored in a different location than 
non-Device Template graphics. 

● The .fnl files for standard graphics are stored in A:\wsroot\graphics. 

● The .fnl files for Device Template graphics are stored based on the Application ID 
of the FLN Device in question (for example: A:\wsroot\graphics\applications\2486. 

● Media files for standard and Device Template graphics are stored in 
A:\wsroot\graphics\media. 

● Graphics can be published to the B: drive, and may need to be deleted from that 
location. 

● Once graphics are backed up, they also reside in the Internal Flash Drive (IFD), 
and may need to be deleted from that location. 

In order to delete a graphic entirely so it will not appear in the User Interface, the file 
must be deleted from the Graphics folder in A:\wsroot. This can be done through the 
HMI (see the Field Panel Features for BACnet Field Panel Web Server section as well 
as the example at the end of this section) or through FINlite (see the Deleting Graphics 
Using FINlite section). 

In order to delete graphics files to create more memory space, you must first determine 
which graphic files to delete. You must then determine which media files are being 
used by that graphic. If no other graphics are using the media files, then they can be 
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deleted. However, if you delete a file that is needed by another graphic, then that 
graphic will no longer work. 

 

 

 

CAUTION 

Deleting Graphic Files 

Before deleting graphic files, you must be certain that no component of that file is 
being used in another graphics file. 

 

 

 

 WARNING 

Deleting Graphics Files from All Locations 

You must also be sure to delete .fnl files and associated media files from all locations 
(such as the B: drive and/or IFD). 

 

Deleting Graphics Using FINlite 

 

 

NOTE: 
Deleting a graphic from Drive A also deletes it from the IFD. 

Deleting a graphic from Drive B does NOT delete it from the IFD. 

To delete a graphic file from the field panel using FINlite: 

1. Click the Delete  icon to the right of the graphic name in the navigation pane: 

 A confirmation window displays the drive from which the graphics file is being 
deleted. 
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2. Select Yes. FINlite will appear frozen, and a confirmation window will display: 

 

3. You can cancel the progress window by selecting the X button at the top right. This 

will allow you to continue working in FINlite while the deletion process continues. 

 When the deletion process is completed successfully, the progress window 
updates to indicate success. The graphics list is updated in the navigation 
pane. 

4. Click OK: 
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FINlite Graphics Deletion Errors 

● When the deletion process is not successful, for example, because the drive was 
removed, the progress window will update to indicate failure. Click OK to remove 
the progress window: 

 

● The panel supports the deletion of only one graphic at a time. When more than one 
graphic deletion request has been made to the panel, the progress window will 
update to indicate that the panel is busy. FINlite will retry in one minute. To cancel 
the subsequent attempt, click Cancel: 

 

● If a request is successfully initiated, but no response is returned within five 
minutes, the progress window will update. FINlite will attempt several retries. To 
cancel the subsequent attempt(s), click Cancel: 

 

● If an original request or subsequent retry request is not successfully initiated, and 
the application detects panel communication failure, the progress window will 
update to indicate that no response from the panel will be received: 
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Example: Deleting a Graphic from the BACnet Field Panel 

Web Server 

Viewing Directory Structure 
 

 Point, Application, Time, Message, Cancel, System, passWord, Bye? s 

Diagnostics, Users, dSt, Bacnet, Error_msgs, Hardware, Text, Quit? h 

Fieldpanels, Ethernet, nodeNametable, Disks, Reportprinter, 

Licensemanager, Quit? f 

Log, Display, Add, dElete, Modify, Config, Filesys, Quit? f 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? l 

 

08/05/2011 FRI Drives List 11:49 

------------------------------------------------------------------ 

Disk Size Free Space 

 

IFD 10 MB 7445 KB 

A:\ 8174 KB 5380 KB 

End of report 

 

Verifying Graphic before Deleting from IFD Directory 
 

 Point, Application, Time, Message, Cancel, System, passWord, Bye? s 

Diagnostics, Users, dSt, Bacnet, Error_msgs, Hardware, Text, Quit? h 

Fieldpanels, Ethernet, nodeNametable, Disks, Reportprinter, 

Licensemanager, Quit? f 

Log, Display, Add, dElete, Modify, Config, Filesys, Quit? f 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? s 

Drive name : --------------------------------ifd 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? d 

 

08/05/2011 FRI File Directory 10:09 

----------------------------------------------------------------------

- 

Path: IFD:\ 

08/04/2011 17:47:37 4056 wsroot\Graphics\PURPLE.FNL 

*** 
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Deleting Graphics 
 

 List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? s 

Drive name : ifd 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? f 

Copy_file, Rename_file, Move_file, Delete_file, Quit? d 

File name : wsroot\graphics\purple.fnl 

Are you sure : y 

Deleting wsroot\graphics\purple.fnl... 

wsroot\graphics\purple.fnl deleted successfully. 

 

Deleting the Same Graphic from Drive A 
 

 List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? s 

Drive name : a:------------------------------ 

A:\ 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? c 

File Directory : wsroot-------------------------- 

Path: A:\WSROOT\ 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? c 

File Directory : graphics------------------------ 

Path: A:\WSROOT\GRAPHICS\ 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? d 

 

10/11/2011 TUE File Directory 13:42 

--------------------------------------------------- 

Path: A:\WSROOT\GRAPHICS\ 

10/11/2011 13:38:56 1393 PURPLE.FNL 

End of report 

 

List_drives, Set_drive, listDirectory, Change_dir, File_ops, 

Remove_dir, Quit? f 

Copy_file, Rename_file, Move_file, Delete_file, Quit? d 

File name : --------------------------------------- 

purple.fnl 

>Ok to continue (Y/N) : y 

Deleting purple.fnl... 

purple.fnl deleted successfully. 
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